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What is Endnote? 
Endnote is a program used for managing references.  
 
It allows you to: 

• Collect, store and organize your references 
• Automatically insert references into your research paper 
• Create and format bibliographies according to your preferred referencing 
   style 

 
Why use Endnote? 

• Saves you time – less typing and retyping of reference lists 
• Reduces error – helps avoid mistakes in spelling and referencing style 
• Convenience – easily transport, update and combine reference lists 
• Cost – software is free for Sydney University staff and students 

 
Where do I get the Endnote software? 

http://www.library.usyd.edu.au/databases/endnote/new/getting_started/get.html 
 
What’s new in Endnote 9? 

• Backwards Compatibility – compatible with Endnote 8 but not earlier versions 
• Transferring Preferences/Modified Reference types between Computers 
• Unicode Support – allows searching of foreign language catalogues and download unicode 

characters into Endnote libraries 
• New Reference Types and Updated Styles 

For a more information see: 
http://www.library.usyd.edu.au/databases/endnote/new/getting_started/endnote9.html 

 
Opening an existing Endnote library 
An Endnote ‘library’ is a file that contains a collection of references.  
Endnote libraries will have the file extension, ‘.enl’ 
 
To open: 

1. Click on the icon to open Endnote 
2. A panel will appear on first opening Endnote. Choose ‘Open an existing library’. Click on 

Browse and search for the file called, ‘paleo.enl’ 
 (Alternatively, you can go to the File menu and choose ‘Open’ to locate a library to open.) 
3. The library, ‘paleo’ will be displayed. 
 

*Each line in the Endnote library represents one reference. Double click on a line to display the 
entire contents of the reference. 
 
Creating your own Endnote library 
As with the steps above, either: 

• Choose ‘Create a new Endnote library’ from the panel that appears on first opening Endnote or  
• Go to the File menu and choose ‘New’ 
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Adding references to your Endnote Library – 3 ways 
 
There are many ways to enter references into Endnote. These include typing in your reference by hand 
and downloading them from databases, library catalogue or other Endnote libraries. 
 
Which way is best? 
This depends on: 

• Download options available from the databases you wish to use and  
• Your own requirements for the format of your references in your research paper 

________________________________________________________________ 
Method 1:  
 
Manual entry – typing in your references 
 
Use this method when: 

• You’re learning how Endnote works 
• It’s not possible to download and/or import references from a database or library 

 
To enter a reference: 

1. Open your Endnote library 
2. From the top menu, go to References 
3. Choose New 
4. The new reference window will open. 
5. Decide what type of reference you have. Eg. Journal article, book, etc. 
6. From the Reference type menu above the reference window, choose the appropriate 

reference type for your reference. 
 

*Parts of your reference: 
  Each part of your reference, eg. Author, title etc. must be entered in a particular way. 
 

For example: 
Enter: ‘Charles Dickens’ as, ‘Dickens, Charles’ 
 
This will ensure that the reference will be formatted correctly when you insert it into your Word 
document. 
 
For a full set of rules for this session, refer to the yellow handout called ‘Using the Australian Guide 
to Legal Citation with Endnote’. 

 
7. Enter each component of your reference into the appropriate section of the new reference 

window in the format outlined on page 6 of your yellow AGLC2 booklet. 
 

* A variation of this method is to ‘cut and paste’ a set of references from an electronic source, which 
may be quicker and more accurate than typing. 

 
8. Close the new reference window. 
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Method 2: 
 
Downloading and/or importing references from a database 
These are the most common ways of getting references into your Endnote library. 
 
These 3 options are listed in order of convenience and efficiency: 

a. Direct export 
b. Download reference file, then import into Endnote 
c. Using connection file to download references 
 

How to find out which of these options to use with a particular database 
The Library has compiled a ‘how to’ list for most databases available at Sydney University. These 
instructions will tell you what options you have for downloading from each database and instructions 
for how to do it. 
 
See the list at:  

http://www.library.usyd.edu.au/databases/endnote/new/databases/dbases.html 
 
Option a: Direct Export 
With Direct Export, your starting point is the database. You then export your references directly into 
Endnote.  
You must have Endnote loaded on the computer you are using for Direct Export to work. See page 2 
for help on how to download the software. 
 
This diagram demonstrates how Direct Export works: 
 

 
 
 
 
 
 
 

 

Endnote 

(a) Direct export 
 
 
 
 
 
 
 
 
 
 

Database 
Eg. LegalTrac 

file

Computer
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Demonstration: Direct Export using LegalTrac 
1) Mark records to be saved. 
2) Click Marked Items. 
3) Click How to cite marked items. 
4) In the Export to third party software field, choose EndNote and click Export. 
5) Click Open. 
6) Choose your EndNote library. 
7) Your records will automatically be imported. 
 *Note: Direct export method exports the Journal title to the notes field. You will need to ‘cut 
and paste’ it into the Journal title field. 
Demonstration: Direct Export with ABI Inform 
Direct Export can be used for all databases on the Proquest platform. 
 
Steps: 

1. Do your search and select references by clicking the checkbox beside each one, or click Mark / 
Clear all on page 

2. Click View marked articles 
3. Click Export citations into EndNote, ProCite, RefWorks or Reference Manager. 
4. On the Export citations page, click Export directly to ProCite, EndNote or Reference 

Manager 
5. EndNote will open. Select or create the EndNote Library you wish to use 
6. You will need to edit each reference by cutting and pasting the year of publication from the 

date field into the year field.  

Option b: Download reference file, then import into Endnote 

This second download variation requires an extra step after searching the database: 

• Download your results to a location on your computer or external disk drive  
• Import the reference file into Endnote 

 

Database 

         Endnote 

file 1. Download to computer 

file 

2. Import into Endnote 

filter

Computer

(b) Downloading results file, then 
importing into Endnote 
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Use this method when: 

• You can’t use Direct Export from the database 
• You don’t have Endnote loaded on the computer you are using for database searching 

 
Demonstration: Downloading references from AGIS 
As with other databases on the Infomit platform, it is possible to download references for import into 
Endnote.  
 
Remember:  

• If you want to import references into Endnote, you must only search one Informit database at 
a time. 

• You may need to download the filter file into Endnote before successful importing is possible. 
See below for more information about filter files. 

 
Step 1: Search and download reference file 

1. Perform your Informit search  
2. Select the references you wish to save by checking the box next to each citation.  
3. Click Save  
4. Under label format, choose Short Labels.  
5. Under Fields to Save, choose Complete Record.  
6. Under Output Format, select Plain Text.  
7. Click Save Records.  
8. Name the file and ensure it is saved as a text (.txt) file . 

Step 2: Import reference file into Endnote 

1. Open Endnote  
2. File>Open  
3. Choose a reference library in the Select a Reference Library window.  
4. Click Open.  
5. File > Import…  
6. At Import Data File click Choose File and browse to the downloaded text file of references 

you wish to import.  
7. At Import Option choose the appropriate database filter. If the filter does not appear on the 

picklist, click Other Filters....  
8. The Filter Manager opens. 
9. A list of database providers is displayed. 
10. Locate the import filter for your database  
11. Highlight and click the ‘uq_agis_informit’ filter  
12. Select the duplicates option from the Duplicates picklist.  
13. Click Import.  
14. The citations from the database should now be in your Endnote library. Check the imported 

references to ensure that the data has been imported correctly. References from some databases 
will require manual editing.  

15. Names of corporate authors will not be imported correctly 
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What are filter files and where do I get them from? 
Filter files are used by Endnote to help it ‘read’ the contents of reference lists that you wish to import 
into your Endnote library. The filter file tells Endnote where to put each part of each reference that you 
download. 
 
While Endnote comes with many standard filters, you may need to download additional filters for the 
databases you are using.  
 
Try these locations for additional filters: 
 

University of Queensland: 
http://www.library.uq.edu.au/faqs/endnote/filters.html#uqfilters 
 
Endnote website: 
http://www.endnote.com/support/enfilters.asp 

 
Ok, I’ve found the filter I need, what do I do now? 

1. Right click on the link to the filter file 
2. Choose ‘Save target as’ (or follow instructions on the web page) 
3. Make sure the file extension is ‘.enf’. 
4. Save the filter file into the Filters folder within the Endnote program folder 

(this is usually located in the Program files folder on your C drive.) 
5. In Endnote, go to Edit-Import Filters-Open Filter Manager 
6. Find the new filter and check the box next to it 
7. Close the Filter manager 
6. When you now go to import a reference file, the new filter should appear in your list of ‘Other 

filters’. 
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Option c: Using a connection file to download references 
This involves connecting to databases or library catalogues via the Endnote search interface, then 
downloading the results directly into your Endnote library.  
 
You will also need to choose the appropriate Connection file in order to search and download search 
results from your chosen database or catalogue. See below for more information about Connection 
files. 

 
 
 
 
Warning: Endnote’s search interface is very simple compared to those used in most databases so this 
method is not recommended unless: 

• You know the exact details of the item/s you’re looking for 
• You plan to do a very simple search 

 
How to use connection files to search via Endnote: 

1. Go into Endnote 
2. From the top menu, go to Tools 
3. Choose ‘Connect’ 
4. Choose ‘Connect’ again 
5. Choose the library catalogue or database you wish to connect to (eg. University of Sydney) 
6. Put in the appropriate password if prompted (Get the database password from MyUni) 
7. Choose ‘Connect’ 
8. You are now connected to your chosen catalogue or database 
9. Perform your search 
10. The search will run, then a window will pop up asking you to accept the references found. 
11. Choose ‘Ok’ 
12. Click on ‘Copy all references to..’ 
13. Choose the Endnote library where you want the found references to go 
14. Your references will be copied into your chosen Endnote library. 
15. Edit your downloaded references if required 

 
Database/catalogue 

  
 
 

Endnote 

 
 

Computer

Connection
File 

1. Connect to 
database and  

search 2. Download  
results into  

Endnote Library 



University of Sydney, Law Library, Introduction to Endnote 9 for Legal Research. M. Harrison, 3/06 9

 
What are connection files and where do I get them from? 
An Endnote connection file allows Endnote to search and retrieve references from some online 
databases and library catalogues. As with Filter files, many come standard with the Endnote software. 
Others you may need to download into Endnote yourself. 
 
Try these locations to find a Connection file you need: 
 

University of Queensland: 
http://www.library.uq.edu.au/faqs/endnote/connect.html#alpha 
 
Endnote website: 
http://www.endnote.com/support/enconnections.asp 

 
Ok, I’ve found the connection file I need, what do I do now? 

1. Right click on the link to the connection file 
2. Choose ‘Save target as’ (or follow the instructions contained on the web page) 
3. Make sure the file extension is ‘.enz’. 
4. Save the connection file into the Connections folder within the Endnote program folder 

(this is usually located in the Program files folder on your C drive.) 
5. When you now go to connect to this database or library catalogue, the new connection should 

appear in your list. 
 
Method 3: 
 
Importing references from another Endnote library  
This method is similar to importing a reference list from a database. 
 
Use this method when: 

• You want to share references with a colleague 
• You want to synchronize an Endnote libraries kept in multiple locations eg. Work and home. 

 
How to do it: 

1. Open Endnote and choose the library you wish to import new reference into 
2. Go to the top menu and choose ‘File’ 
3. Choose ‘Import’ 
4. On the Import panel, choose your file (in this case, the endnote library) 
5. The Import Option should be set to ‘Endnote library’ automatically 
6. Choose whether you wish to import all, remove duplicates etc. 
7. Choose No text translation 
8. Remove duplicates if required 

 
Warning: Removing duplicates 
Endnote gives you the option to remove duplicates from your Endnote library when importing and as a 
separate function. 
 
Remember: The default setting for Endnote to consider a reference to be a duplicate is if the author, 
year, title and reference type match. 
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You can change this setting if you are working with references that may be very similar in other 
components of the citation. Eg. place published.  
 
To remove duplicates: 

1. Open your Endnote library 
2. Go to the top menu and choose ‘References’ 
3. Choose ‘Find duplicates’ 
4. If duplicates are found, they will appear together, with one version highlighted 
5. Check that the references are indeed identical 
6. Go to the top menu and choose ‘References’ 
7. Choose ‘Delete references’ 
8. Choose ‘Show all references’ from the References menu. 
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Sorting, searching and previewing your references 
 
Sorting: 

1. Open your Endnote library 
2. Go to the top menu 
3. Choose ‘References’ 
4. Choose ‘Sort References’ 
5. Select your required sorting criteria 

 
Searching: 

1. Open your Endnote library 
2. Go to the top menu 
3. Choose ‘References’ 
4. Choose ‘Search References’ 
5. Select your required search criteria 
6. Only the references matching your search criteria will be visible 
7. Follow steps below to revert to showing all references in your library.  

 
Showing all references in your library: 

1. Go to the top menu 
2. Choose ‘References’ 
3. Choose ‘Show all references’ 

 
Preview references – to see how they will look in your research paper: 

1. Open your Endnote library 
2. Highlight a reference 
3. Go to the top menu 
4. Go to ‘Tools’ 
5. Choose ‘Show Preview’ 
6. The reference will be displayed in your chosen reference style (or ‘Output style) 
 

Changing your reference (output) style 
1. Follow the steps above to show the preview of the reference style 
2. Go to the reference (output) style window below the top menu 
3. Click on the drop down menu and choose a different style eg. Change the style from ‘Author-

Date’ to ‘Numbered’ 
4. See how the reference style changes in the preview window 

 
Add a reference (output) style to your favorites list 

1. Go to the top menu 
2. Go to ‘Edit’ 
3. Choose ‘Output styles’ 
4. Open Style Manager 
5. Find the new Output style from the list 
6. Put a check in the box 
7. Close the Style Manager 
8. Repeat the steps above for ‘Changing your reference style’, listed above. 
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Using the Australian Guide to Legal Citations 2nd ed. (AGLC2) with 
Endnote 
The Australian Guide to Legal Citations 2nd ed (AGLC2) is a reference style, like the Harvard or the 
Chicago style, which provides a uniform guide to legal citation. It has been adopted by many 
Australian law journals including the Sydney Law Review, Melbourne University Law Review and the 
University of New South Wales Law Review. 
For more information see: http://mulr.law.unimelb.edu.au/aglc.asp 
 
In Endnote, templates for these reference styles are known as Output styles. Endnote comes 
prepackaged with many common Output styles. Each ‘Style file’ is a set of instructions that tells 
Endnote how to display your references in your chosen Output style. They are collected together in a 
folder called Styles inside the Endnote program folder. If you don’t want to use one of these standard 
styles you can either: 
 

• Download a new Style file you prefer to use (free from the Web) 
• Edit one of the standard Style files already contained in Endnote 
• Create a new Style file from scratch   

 
AGLC2 Style file 
AGLC2 does not come prepackaged with the Endnote program so you will need to download the Style 
file before you can use it in Endnote. 
 
The University of Queensland Library has already created an Endnote Style file for AGLC2, so all you 
have to do is download it into your Endnote Styles folder and make a few minor adjustments to 
Endnote in order to make it work. 
 
Downloading the AGLC2 Style files 
1. Go to: http://www.library.uq.edu.au/faqs/endnote/styles.html#alpha 
2. Find the AGLC2 style files. There are 2 variations. Choose the version you think suits your 

purposes. 
3. Place your cursor on the link to the file 
4. Press Shift-click to save 
5. Save the file to your Endnote Styles folder (Should be in your C drive-Program Files-Endnote) 
 
Adding AGLC2 to your Output style favorites list 
1. Open Endnote 
2. Go to the top menu and choose ‘Edit’ 
3. Choose ‘Output styles’ 
4. Choose ‘Open style manager’ 
5. Find the AGLC2 file (Should be called ‘uq_aglc2_footnotes…’) 
6. Put a check in the box 
7. AGLC2 is now part of your favorites list 
8. To check, open an Endnote library with the preview window showing 
9. Highlight a reference in your library 
10. Change the Output style to AGLC2 from the Output style drop down menu 
 
*Tip: you may want to give the style a category eg. ‘Legal’. How to do it: 

1. Go into the Style Manager 
2. Highlight the style 
3. Choose ‘Edit’ and  
4. Type in ‘Legal’ in the blank category window. 
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Obtaining a custom reference type for legal citations 
• AGLC2 does not use the standard Endnote legal reference types (Hearing, Bill Statute, Case). If 

you use these types for your references, the AGLC2 Style file can not format them correctly. 
• The reason is that Endnote has not been programmed to format legal citations according to 

jurisdiction. 
• The easiest way to get around this problem is to have one single legal reference type where you 

enter all ‘legal’ citations according to AGLC2. 
• ‘Legal’ citations in this context typically means cases, legislation and treaties. 

 
How do I get the Legal Reference type? 

1. Download it 
2. Create it yourself 
 
Option 1: Downloading a pre-made Reference Type Table 
From Endnote versions 8 onward it is possible to download a file created by the University of 
Queensland that contains the Legal Reference type already made. To do this: 

1. You must read through steps 1-8 before starting 
2. If you want to keep a copy of your original RefTypeTable file follow steps 4-8 
3. Otherwise skip to step 6 
4. Create a folder called Original at: 

C:\Documents and Settings\[your user name]\Application Data\EndNote 
5. Move the original RefTypeTable file into the ‘Original’ folder 
6. Go to: http://www.library.uq.edu.au/endnote/aglc2/ 
7. Right click on the file called ‘RefTypeTable.xml’ save the file in the following directory 

of your computer:   
C:\Documents and Settings\[your user name]\Application Data\EndNote  

8. When asked confirm that you wish to replace your existing RefTypeTable file. 
 

Option 2: Creating the ‘Legal’ reference type: 
1. Open Endnote 
2. Go to the top menu and choose ‘Edit’ 
3. Choose ‘Preferences’ 
4. Choose ‘Reference types’ 
5. Click on ‘Modify reference types’ 
6. Scroll through the reference types until you get to ‘Unused 1’ 
7. Delete this name and call it ‘Legal’ 
8. Insert the text exactly as it appears in the diagram provided (see Figure 1 on the 

following page) 
9. Click OK to confirm changes and close window. 
10. You have now created a custom reference type for legal reference types. 
11. Test out your custom reference type by manually entering a case law citation using the 

Legal reference type 



Generic Legal 
Author   
Year Year 
Title AGLC Citation 
Secondary Author Jurisdiction 
Secondary Title   
Place Published   
Publisher   
Volume   
Number of Volumes   
Number   
Pages   
Section   
Tertiary Author   
Tertiary Title   
Edition   
Date   
Type of Work   
Subsidiary Author   
Short Title   
Alternate Title   
ISBN/ISSN   
Electronic Resource 
Number   
Original Publication   
Reprint Edition   
Reviewed Item   
Custom 1   
Custom 2   
Custom 3   
Custom 4   
Custom 5   
Custom 6   
Custom 7   
Accession Number   
Call Number   
Label Label 
Keywords Keywords 
Abstract Abstract 
Notes Notes 
Research Notes Research Notes 
URL URL 
Link to PDF   
Author Address   
Image   
Caption   
Access Date   
Last Modified Date   
Translated Author   
Translated Title   
Name of Database   
Database   
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Using Endnote with Microsoft Word  
Now that you have mastered the basics of Endnote you can use it with Microsoft Word to insert and 
format references in your research paper. 
Note: If maintaining libraries on the same topic in multiple locations (eg. home and work) it is 
recommended that when writing on a paper you insert references from only ONE of these libraries.  
 
Before you start: 
1. Open Word 
2. Ensure that the Endnote toolbar is installed in Word. 
 
**In the interests of saving time, this has already been done for you for this class. 
 
Instructions for doing this at home are available from the FAQ list at: 
http://www.library.usyd.edu.au/databases/endnote/new/faq/faqintro.html 
 
3. Open a new Word document and save the file to the Temp (D) drive 
4. Disable Instant formatting 
 

The default setting when using the Endnote toolbar with Word is to format your 
bibliography automatically. This function is also known as Cite While You Write 
(CWYW). It is recommended that you start by turning off this function then 
periodically format your footnotes to make sure they are displaying correctly. 

 
I. Click on the Cite While You Write Preferences button (mouse over the buttons to find it) 

II. Uncheck the box for Enable Instant Formatting. 
III. Close the panel 
IV. Click on the Format Bibliography button (mouse over the buttons to find it) 
V. Go to the Instant Formatting tab 

VI. Make sure the setting is Enable 
VII. Click Ok 

5. Type some text into your document 
6. Click on ‘Insert’ from the top menu in Word 
7. Choose ‘Reference’ 
8. Choose ‘Footnote’ 
9. When the Footnote panel opens, choose ‘Footnote’ in the Location section and ‘Continuous’ in the 

Format section 
10. Click Insert 
11. The footnote will appear at the bottom of your page. 
12. If you wish to type some text before your reference, type it first, then make a space. 
13. To add your reference, go to the Endnote toolbar and click on the ‘Go to Endnote’ button (mouse 

over the buttons to find it) 
14. Endnote will pop up. Highlight the reference your wish to insert. 
15. Click on the ‘Insert Citation’ button in the top left hand corner, above your references (mouse 

over the buttons to find it) 
16. Word will pop up again. Your reference will then be inserted into your footnote. 
17. Adding additional text to each footnote: 

I. No additions: type a full stop after the reference and return to your text. 
II. Cite a second reference in the same footnote: type a semi colon and a space before inserting 

the second reference, then do step (I) 
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III. Add a pinpoint citation: type the details after the reference. Some reference types (eg. journal 
article, Australian cases) require a comma before the pinpoint citation, then do step (I). 

18. Repeat these steps for each footnote you wish to add.  
19. Format you bibliography (see step below) 
 
Omitting Part of a Citation   
If you quote the name of a case in the text of your document, the case name should not be repeated in 
the footnote (AGLC2 2.1.10).  
The footnote will only contain the details of where the case report is published, plus any pinpoint 
citation.   
Similarly, if a piece of legislation is mentioned by name in the text, there is no need to cite it in a 
footnote unless further details are required to locate it, or unless a pinpoint citation is required.   
 
If the footnote is to contain only part of a citation,  

1. Type the required details in the footnote, and do not insert the reference using EndNote (copy 
and paste the details out of the AGLC2 field in Endnote)  

 
Remember: 
If you want EndNote to format a separate bibliography at the end of your document, be aware that this 
reference will not appear in the bibliography if you have not used EndNote to insert the reference 
somewhere in your document.  
 
To include in the bibliography references which you have typed yourself or inserted with copy and 
paste, see below: ‘Including references in your bibliography that were not inserted using Endnote’ 
below. 
 
Repeat Citations   
When citing a work that has already been cited in the previous footnote, do not use EndNote to insert 
the repeat citation.  

2. Type 'Ibid' or 'ibid' as specified in AGLC2 1.2.1. 
 
When citing a source (other than a case, a treaty or a piece of legislation) that has been cited in an 
earlier footnote (but not the previous footnote), do not use EndNote to insert the repeat citation.  

3. Type the abbreviated details in the form specified in AGLC2 1.2.2.   
 
*See the yellow handout (Using Australian Guide to Legal Citation 2 with Endnote) for further details 
on repeat citations. 
 
Including references in your bibliography that were not inserted using Endnote 
To make these references appear in the bibliography, proceed as follows:   
 

1. Insert a page break at the end of your document.  
2. On this new page, insert all the relevant references, one after another. To do this: 
3. Highlight the reference in Endnote.  
4. Go back to Word 
5. Click on the ‘Insert Selected Citation’ button 
6. It is probably wiser to do this on a continuing basis as you are writing the document, but it can 

be done in one step once you have finished writing.  
7. In each of the temporary citations, delete the author name (if any) and the year, leaving only the 

reference number, e.g. {#17}   
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8. If you are inserting a reference using the ‘Legal’ reference type, there is no need to delete 
anything 

9. You are now ready to format the references and bibliography.  
10. Click on the Format Bibliography button on the toolbar.  
11. Before formatting, click on the Layout tab.  
12. In the Bibliography Title box, enter the heading that you would like to appear, e.g. 

Bibliography. Then format the bibliography. 
 
Formatting your bibliography 
Once you have inserted a few references, you will need to periodically format them: 
 
1. Click on the Format Bibliography button 
2. You document should be listed in the panel. Choose your preferred Output style. 
3. Click Ok 
4. Check that your references have been formatted correctly. 
 
Removing field codes 
Once you have finished formatting your document, if you want to send it to a publisher, it is good idea 
to remove the field codes that Endnote inserts as this can interfere with the publisher’s software. Once 
you remove the field codes, the document is no longer ‘linked’ to Endnote so it can not be reformatted. 
 
1. Open your document in Word 
2. On the Endnote toolbar, click on the Remove Field Codes button. (mouse over the Endnote toolbar 

to find the button) 
3. You will be sent a message explaining that this command creates a new, unsaved document. Click 

Ok to accept. 
4. Save the new file with a different name from the original. 
5. You must keep the original document because it is your master document. Any future changes will 

have to be made to this original document. You  then generate a  new, unlinked version for the 
publisher. 
 

Creating Independent Bibliographies 
Sometimes you may need to generate just a bibliography without the relevant research paper included. 
There are 2 main ways to do this: 
 
• Copying formatted text 
• Export the records 
 
Copy formatted text 
1. Choose your selected Output style (In the Endnote edit menu) 
2. Highlight the references you wish to include in the bibliography 
3. Click on Edit, choose Copy Formatted 
4. Paste the references into your Word document. 
 
Exporting the references 
1. Open your EndNote library 
2. Select your chosen references  
3. References > Show Selected References. To export the entire contents of the Library: References 

> Show All References.  
4. To change the order they appear in: References > Sort References.  
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5. Select your chosen bibliographic style 
6. File > Export 
7. Select File Type 
8. Choose Rich Text or HTML as they support styled text.  
9. Choose Text if the file is for data transfer.  
10. Name the export file and browse to where you will save it.  
11. Click Save 

 

 

 

Further information: 
 
• University of Sydney Library  
• http://www.library.usyd.edu.au/databases/endnote/endnote.html 
- Tutorials 
- Download help for University of Sydney databases 
- FAQs 
 
• University of Queensland Library 
• http://www.library.uq.edu.au/faqs/endnote/ 
- Tutorials 
- Filters, Connection files, Style files 
- Guide for using AGLC2 with Endnote  
 
• Endnote website 
• http://www.endnote.com/support/ensupport.asp 
• Endnote 9 User Guide (6.4Mb) : 

http://www.endnote.com/support/helpdocs/EndNote9Manual.pdf 
- Email lists, FAQs etc. 
- Filters, connection files, style files 
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